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1.0 Introduction

VbReader is an off-line reader program which runs under Microsoft Windows 3.1. It
allows you to manage your electronic mail from Bulletin Boards whose mail packets
conform to  the  Quick  Mail  format.  VbReader incorporates  the  features  needed  to
unpack  mail  packets,  read  the  messages,  write  replies  and  generate  a  mail  packet
containing the replies.

The benefits of using VbReader are:

- easy to use, fast and reliable
- low registration price, no upgrade charges
- written in Visual Basic and C to provide the most modern user interface possible
- takes complete advantage of the Microsoft Windows 3.1 environment and capabilities
- user configurable
- full font capability which makes it suitable for many languages
- handles up to 10,000 conferences
- large replies up to 30K bytes are automatically broken up into individual messages
- query capability allows searches of key words in titles or mail text
- built in ANSI viewer
- ability to add or delete conferences within the program

Users of this program will require a communication program to perform the download
and upload of mail packets to the bulletin board of their choice.

1.1 VbReader Support

VbReader is being marketed as Shareware and program registration is required after a
trial usage. The full capabilities of the program are in the unregistered package so the
potential customer can test VbReader completely on their system.
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The  author  intends  to  actively  support  development  of  VbReader.  Comments  and
suggestions are encouraged; users can send Email to him via USENET at:

daniel.page@canrem.com

or on NANET (NorthAmericaNET) from Canada Remote Systems BBS as user:

DANIEL PAGE

The author can also be reached on the RIME and INET Windows conferences.

VbReader is being distributed by Dirac Systems and will be supported by the author on
Dirac Systems' BBS at modem (416)283-7157. Users can download the latest version of
the program or upload trouble reports and messages at no cost.

1.2 Registration

Registration is easy. You register  VbReader by sending in CAN$25.00 to the address
below. You then receive your own serial number and key by mail which you put into the
version  of  VbReader that  you  are  using  by  running  Quick  Configuration  |
Registration from the menu.

The  registration  key  requires  the  BBS user  name you use  in  the  VbReader  Quick
Configuration  |  Tag  Line menu  for  Your  Name.  Please  use  the  order  form,
ORDERFRM.WRI, which is in WRITE format and can be printed out from Windows.

You can register by charging to your  VISA or  MasterCard account; please use the
order form that accompanies the distribution files. Province of Ontario customers need
to  include  the  additional  Provincial  Sales  Tax  (PST).  If  you require  a  copy  of  the
software, please include CAN$10.00 plus PST. Send your registration to:

Dirac Systems
Attn: VbReader
P.O. Box 476
West Hill, Ontario
Canada M1E 4Y9

There are no upgrade fees for VbReader.

2.0 Red Tape

VbReader is being marketed as Shareware. You are able to try out the full capabilities
of the program. After a short trial period you will have had the opportunity to evaluate
the compatibility of the software with your system and whether you wish to continue
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using it. You will then be expected to purchase a registered copy.

2.1 Disclaimer of Warranty

This  software  and  documentation  are  provided  'as  is'  and  without  warranties  as  to
performance of merchantability or any other warranties whether expressed or implied.
Because of the various hardware and software environments into which these programs
may be put, no warranty of fitness for a particular purpose is offered.

Good data processing procedure dictates that any program be thoroughly tested with
non-critical data before relying on it. The user must assume the entire risk of using the
program. Any liability of the seller will be limited exclusively to product replacement or
refund of purchase price.

2.2 Copyright Notice

VbReader is Copyright (c) 1992-1993 by Daniel Page. Dirac Systems is acting solely
as a distribution agent and claims no ownership, copyright, liability, or maintenance of
VbReader.

2.3 Distribution Kits

The  major  means  of  distribution  of  VbReader is  by  the  BBS  networks.  You  will
download a compressed package called either  VBREnnnL.ZIP or VBREnnnS.ZIP,
where  nnn is the version number multiplied by 10 (for example, version 1.50 would
have  nnn = 150).  VBREnnnL.ZIP (Large kit) contains all  the files required to run
VbReader; in particular, it includes VBRUN200.DLL and a file with a larger number of
taglines. Otherwise, VBREnnnS.ZIP (Small kit) is missing VBRUN200.DLL and has a
file with a smaller number of taglines.

The kits may be distributed on Bulletin Boards, diskettes, etc. provided they are kept
intact.

The distribution kits contain the following files (except as noted above):

READER.EXE: Main VbReader Program
VBANSI.EXE: ANSI viewer for Microsoft Windows
VBRUN200.DLL: Microsoft Visual Basic 2.00 Dynamic Link Library
VBREADER.DLL: VbReader Custom Dynamic Link Library
SETUP.EXE: Setup program to install VbReader
VBRSETUP.EXE: Custom setup
SETUP.LST: List of files for SETUP.EXE to install
SETUPKIT.DLL: Setup program Dynamic Link Library
VER.DLL: Windows version control Dynamic Link Library
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CMDIALOG.VBX Microsoft Visual Basic common dialog extension
THREED.VBX: Microsoft Visual Basic 3D Controls extensions
EXPLODE.PIF: PIF file to launch PKUNZIP.EXE
COMPRESS.PIF: PIF file to launch PKZIP.EXE
8514OEM.FON: Large terminal font
8514FIX.FON: Large fixed pitch font
VGAOEM.FON: Small terminal font
VGAFIX.FON: Small fixed pitch font
README.WRI: Read this new information first in Microsoft Write format
VBREADER.WRI: This documentation in Microsoft Write format
ORDERFRM.WRI: Order form for registration

Additional sample files:

FILES.PIF: PIF file used to launch the files display editor
TAGFILE.TXT: Text file containing taglines

2.4 Upgrade Policy

In order to provide our customers with advances in performance and convenience there
will  be  new  versions  of  VbReader from  time  to  time.  Maintenance  releases  will
increase the version number in the hundredth's digit of the version number, for example,
3.10 to 3.11; this is a minor release which will fix small problems. Product improvement
releases will increase the version number in the tenth's digit of the version number, for
example, 3.11 to 3.20; this is also a minor release. Major product changes will require
increases  in  the  version  number,  for  example,  2.11  to  3.00;  this  would  mean  a
significant  functionality  change.  Changes  are  not  whimsical;  they  are  the  result  of
customer  input  leading  to  careful  development  and  testing.  A number  of  fixes  or
improvements constitute a change so that releases are not too frequent. Releases that are
referred  to  as  minor  will,  in  fact,  provide  some  more  substantial  abilities  or
improvements.

Minor revisions will normally have no cost increase; there may be cost changes due to
circumstances  beyond our control,  as  in  changes  to  taxes,  mail  rates or inflationary
pressures. Since prices are subject to change, please refer to the latest Shareware release
or  Dirac  Systems  to  determine  the  present  upgrade  rates;  incorrect  upgrade  or
registration orders cannot be processed. The upgrade policy and price is guaranteed for
1993.

Registered users of any VbReader version can transfer their registration key and serial
number to subsequent versions. When a Shareware upgrade of the software appears,
registered users are free to use it regardless of its functional change.

A new copy of the latest versions will be sent to registered users if they require one. The
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cost is CAN$10.00 to cover postage and handling. Province of Ontario residents must
add the Provincial Sales Tax (PST) but not the Goods and Services Tax (GST).

2.5 Hardware and Software Requirements

VbReader requires the following:

-  Although  VbReader will  run  on  an  Intel  based  286 personal  computer,  a  386 is
preferred.
- VGA or better video monitor; 800x600 resolution is preferred.
- Microsoft Windows 3.1.
- A telecommunications program to download mail packets and to upload replies.
- PKZIP and PKUNZIP software to compress and expand mail packets.

2.6 Definition of Terms

CRS: Canada Remote Systems.
DOS: Disk Operating System.
ENTER: The Enter key.
IBM: Registered trademark of International Business Machines Corporation.
INSERT: The Insert key.
Microsoft Windows: Registered trademark of Microsoft Corporation.
MS DOS: Registered trademark of Microsoft Corporation.
PgDn: Page Down key.
PgUp: Page Up key.
SPACE: The Space bar.

3.0 Installation

This Section describes the installation of VbReader. This is normally a one time event
and care should be taken to do it correctly. You have to install the files on your disk
drive and then configure VbReader to your liking.

3.1 Installation from Windows

You  should  unzip  the  distribution  file,  VBREnnnL.ZIP or VBREnnnS.ZIP,  in  a
temporary  directory  or  a  diskette.  Start  Windows  File  Manager  and  then  run  the
SETUP.EXE in  the  distribution  kit  by  double  clicking  on  it.  This  will  create  the
VBREADER directory, copy the correct files to it, install the DLLs to the Windows
directory and create a Program Group called VbReader. VbReader will be a Program
Item in the group. The setup program will also launch the Windows font manager to
prompt you to install the required fonts.

3.2 Font Installation
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During the installation, the font manager is launched. Choose the directory or diskette
where you have the distribution files. Four fonts will appear in the list. They are:

Terminal font for the IBM 8514
Fixed pitched font for the IBM 8514
Terminal [US] [Set #6]
Fixed pitched font for VGA screens

Click on the Select All button to select them, then click the OK button. The fonts will
be installed. If the fonts are already installed in your system, Windows will display a
message to that effect; just click OK until all fonts are installed.

In order to function properly, VbReader requires that ALL fonts be installed.

3.3 The Archive Programs: PKZIP/PKUNZIP

VbReader uses  the  programs,  PKZIP.EXE  and  PKUNZIP.EXE,  to  compress  and
expand  messages.  VbReader was  designed  to  use  version  2.04G  of  PKWare's  zip
utilities. The archiver is invoked directly through a PIF file, with VbReader passing the
appropriate  parameters.  If  PKZIP is  on  your  Path,  no  changes  to  the  PIF  files  are
necessary.  If PKZIP is NOT on your Path, use the Windows PIF editor in the Main
Windows Group to edit the command line in the Pif files to point to the directory where
PKZIP is located.

VbReader can use version 1.10 of the zip utilities with a small configuration change.

3.4 Initial Start Up of VbReader

To start  VbReader, you may double-click on  READER.EXE with the Windows File
Manager, or double click on the VbReader icon in the Program Group.

3.5 Initial Configuration

When VbReader is first started, it will look for a configuration file, VBREADER.INI,
in order to set up directories and user preferences. Initially, this file will not exist. The
program will  then  invoke the  configuration menu.  The following options  should be
verified and adjusted to your needs.

3.5.1 Paths and Directories

Examine the directories listed. The defaults provided should be adequate. If you have
specific upload and download directories for your communication program, you should
change the uploads and download paths to those directories so that VbReader will be
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able to access mail packets directly from the communication program's directories.

The Replies directory and the upload directory must be different.

Once you have configured the options, click the Done button. VbReader will proceed
to create the required directories listed in the configuration menu. The program will
notify you for every directory created; just click the OK button to accept each one. The
mail screen is then displayed.

You must now open the configuration menu, Quick Configuration.

4.0 Quick Configuration Menu

Click on the Quick Configuration menu item. There are a number of options you can
choose from:

Screen Options...
Select your screen set up preferences.

Paths...
Set up your various paths for file directories.

Packers and Door Commands...
Set up your archiver software and mail door type.

User Info...
Provide basic user information that can be used in your messages.

Editor Selections...
Choose the various editors you want to use.

FidoNet Mode...
FidoNet requires a special set up for replies.

Registration
Enter your serial number and key after paying for registration of VbReader.

The first option listed under the Quick Configuration menu is Screen Options. Select
this option.

4.1.1 Screen Options Choice

VbReader allows you to configure your reader screens according to your preferences.
Choose the style you find most pleasing; you can always change it to something else
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later on.

4.1.1.1 Font Name, Size and Style

The  Font Name list box allows you to chose the fonts that will be used in the main
view screen, as well as your personal signature text box. Clicking on the button on the
right side of the box will display the font names installed in your system. Click on the
font you wish to use to read and write messages.

You can also alter the appearance of the font by clicking the Font Style radio buttons to
make the font Bold or Normal. In addition, the Font Size text box allows you to select
the size of the font. 

As you select a new font or modify a font characteristic, the text box at the bottom right
of the menu screen will display the result. Choose the font and font style which most
appeals to you.

It  is  recommended  that  you  choose  either  the  Terminal font  or  8514OEM  font,
depending on your screen resolution. Terminal font is smaller and is intended for VGA
screens while  8514OEM is intended for Super VGA screens. In addition,  these two
fonts will allow the display of IBM specific characters such as "happy faces" and so on
which are often used on BBS networks. They are fixed pitch fonts which is what a
standard DOS screen uses; this retains the spatial characteristics of message text. On the
other hand, they are not resizable. For Terminal you should pick 9 points for the font
size. For 8514OEM you should pick 13.5 points for the font size.

VbReader will allow you to use True Type fonts which provide a wider range of sizes
and typefaces. However, they cannot display the IBM specific character set. The text
will  remain  intact  but  the  any  IBM  graphic  characters  will  be  converted  to  an
underscore '_' or some other approximation.

4.1.1.2 Screen Colors

You can choose the foreground and background colors used in the main reader screen
by clicking on the desired colored boxes in the two frames at the bottom left of the
menu screen. You can apply the colors to either the View Screen or the List Header.

The View Screen is screen where you view the message text or a list of messages. The
List Header is located at the top of a list of messages; it merely describes the message
list as: SUBJECT, MSGNUM:, FROM:, and TO:.

The color result is displayed in the sample text box.

4.1.1.3 Opening Size
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This option determines if VbReader will open in full screen mode or in normal mode
when it is invoked. The default is normal mode.

4.1.1.4 Line Length

This option determines where a line wrap will occur when a reply or new message is
entered. While you type a message, the lines will wrap when the text reaches the right
edge of the edit screen. However, because the fonts used and their sizes can be selected
by the user, this wrap may not be at a desirable location. The line may be too long or too
short.  For  this  reason,  the  final  line  wraps  are  inserted  by  the  message  processing
algorithms when a message is saved. This field determines at what character the wrap
occurs. The default number of 76 is recommended.

4.1.1.5 Message Length

The option, Msg Length, allows you to set the normal length of a message. The default
is 99 lines. Your messages may be as large as 30K but  VbReader will automatically
break messages into continued messages if a message is longer than the message length
that you specify.

4.1.1.6 Quote Width

When the text of a message is inserted in a reply, this field determines at what character
position the quoted text will be truncated or wrapped. This field should always be equal
or smaller than the chosen Line Length. When this field is smaller than the Line Length,
the resulting text will be centered in the edit screen.

4.1.1.7 Quote Mode

When you reply to a mail message you will often want to include the original message
to refer to its content. When inserting quoted text in a reply, this option will determine
whether quoted lines that exceed the Quote Width should be truncated or wrapped to a
new line.

Generally the Truncate option with a Quote Width of 76 results in text that is better
formatted. The wrap option works better if the Quote Width is around 40 characters.

4.1.2 Paths Choice

The second option listed in the Quick Configuration menu item is the Paths Choice.
Your normal paths, which must be fully qualified, are determined on the initial set up;
however, you may change them at any time. You are able to set  up or change your
default paths for:
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Work Directory
This is where VbReader expands the message packets.

Downloads
This is where your communication program downloads the mail packets to.

Uploads
This is where your communication program uploads the mail packets from.

Archives
If you save messages as files they will be kept in this directory. See File | Save Message
as Text.

Replies
This is where your replies are kept until creating a reply packet which is complete and
ready for uploading. See File | Create Replies Packet.

Datafiles
This is where your Tag Lines file, Twit list file, etc. are kept.

4.1.3 Packers and Door Commands Choice

The third option listed in the Quick Configuration menu item is the Packer and Door
Commands. Use these to change your archiver commands and mail door type.

Archiver Unpack Command:
You are  provided with  a  PIF  file,  EXPLODE.PIF,  to  use a  DOS based archiver  to
unpack messages. The command, such as C:\VBREADER\EXPLODE.PIF -), is used
to  point  to  the  PIF  file.  The  command  line  argument,  -),  is  recommended  for
PKZIP204G. Make sure that the full path is specified.

Archiver Pack Command:
You are provided with a PIF file, COMPRESS.PIF, to use a DOS based archiver to pack
messages.  The command,  such as C:\VBREADER\COMPRESS.PIF -),  is  used  to
point to the PIF file. The command line argument, -), is recommended for PKZIP204G.
Make sure that the full path is specified.

Archiver Move Switch:
Sometimes your archiver program requires a command line switch for some purpose in
your system. Put or change the switch here. The move switch, -m-, causes the archiver
to  delete  your  replies  during  the  packing process.  Version  1.10  of  PKZIP used the
switch,
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-m.

Mail Door Type:
There are a number of mail formats that you can configure. One of the most popular is
QMAIL but you can also have a choice of:

QMAIL
MARKMAIL
ROSEMAIL
KMAIL
CMPMAIL

4.1.4 User Info Choice

The fourth option listed in the Quick Configuration menu item is the Tag Line menu.
Clicking on this option will invoke the second configuration menu. This menu allows
you to modify the following options:

4.1.4.1 Your Name

This option sets your user name. This is used when entering replies or new messages.

This field is critical for two reasons. An error in this will prevent the mail door at the
BBS from accepting your replies; your reply name and BBS name must agree. Also, this
field is used in the verification of your registration key.

4.1.4.2 Your Tag Line

This is your default tagline.

4.1.4.3 Tag File Name

This is the name of a file containing taglines. This file must reside in the directory listed
in the first configuration menu; normally this is located in the DATAFILE sub directory
of VBREADER. VbReader comes with a public domain file containing 4500 taglines
in the large kit and a few dozen in the small kit; you can substitute your own too. By
default, the file name is  TAGFILE.TXT; it is an ASCII text file with one tagline per
line. You may change this to any name you wish. Just make sure that you tell VbReader
the correct location and name of the tag file, via the configuration menus.

Because of memory usage limitations, VbReader is limited to using only the first 1000
entries in the tagline file.

4.1.4.4 Your Signature Lines
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This  text  box contains the signature text  which will  be appended to the end of  the
messages you write. The font used in this text box is the same as the main read screen
font. Should you wish to make "boxes" or other patterns, make sure that you use a fixed
pitch font to preserve the required spacing. Three such fonts are available:  Terminal,
8514OEM, and Fixedsys. Once your pattern has been entered, you may revert to any
desired  font.  Your  pattern  spatial  characteristics  will  be  distorted,  but  when  your
message is read by the recipient, it will be correct, as most other off-line readers use
fixed pitch fonts.

4.1.4.5 Default BBS

Finally, this box allows you to specify a default BBS name. Once you have read a mail
packet, this field will contain the BBS identity code of that BBS.

After  having set  those  options,  click  Done and  VbReader returns  you to the  main
screen.

4.1.5 Editor Selections Choice

Now select the fifth item in the  Quick Configuration  menu,  Editor Selections. The
following options are displayed:

4.1.5.1 Files List Editor

This option allows you to select the editor which will be used to display the new files
list downloaded from the BBS. The default is the WRITE.EXE program that is shipped
with Windows (Accessories Program Group). You may specify your favorite editor if
you wish. If this editor is a Windows based editor, you need only specify the program
name. If the editor is not in your path, you must include the full path. For example:

DESKEDIT.EXE

or

C:\EDITOR\DESKEDIT.EXE

If the editor is a DOS application, it is best to insert the name of a PIF file which will
supply the required parameters to Windows in order to launch the editor. Normally, this
PIF file will contain the name of the editor and will launch the editor in Windowed
mode. See the example PIF file provided, FILES.PIF.

4.1.5.2 Services Editor
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This editor selection is used to display the services data files downloaded from the BBS.
See the Files List Editor selection above for details in configuring this option.

Services are not supported in this version of VbReader. Should a service packet be
received, you will be able to see a listing of it's contents via the View Items menu.
In order to see the contents you will have to use an external program.

Now return to the main Quick Configuration menu.

4.1.5.3 News, Bulletins, ANSI Viewer

As above, enter the editors you want to view the BBS News, Bulletin, or other ANSI
files.  VbReader comes with its own viewer,  VBANSI.EXE, and will be the default
editor.  The ANSI viewer will  allow you to see the colorful  ANSI graphics that  are
popular on a BBS today.

4.1.6 FidoNet Mode Choice

The sixth item in the  Quick Configuration menu is Fido Mode. This option changes
the tear line characters to a string of character which FIDO BBS systems will allow.
When this option is OFF (unchecked) the reader is PC Board mode, the normal mode.

4.1.7 Mode Français Choice

This mode will change the quote line used when replying to a message.  When it  is
checked, the quote line is in French. To change the Keyboard to French mode, use the
Windows Control Panel, International option. Invoking this option will automatically
launch the Control Panel, International option. You must then pick the language and
keyboard of your choice.

4.1.8 Registration Choice

When you register your Shareware version of  VbReader, you will be sent a special
registration key and serial number which you will enter in the screen form provided. Be
sure to  overwrite  the prompts for your serial  number and key.  They must  be typed
exactly as sent to you. Click on  Register Me! to enter your information. When it is
successful there will be a confirmation message that you are now registered. You will no
longer  see the momentary opening screen when running  VbReader and your  serial
number will appear in the reader identification field of your tagline.

4.2 Saving the Configuration

Whenever a configuration item is changed it will be saved right away.
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5.0 Reading Mail

VbReader is very easy to use due to the adherence to the user interface standards of
Microsoft  Windows.  Likewise,  the  operation  of  VbReader is  simple  and  straight
forward. The purpose of this Section is to guide the user through a typical session with
VbReader.

Typically  you  will  download  a  mail  packet  from  your  BBS.  You  will  need  a
communications  program  and  modem  to  do  this.  Most  packets  follow  the  Qmail
standard which is recognized by VbReader.

VbReader will allow you to read and respond to your BBS mail in the most convenient
way. The main menus are:

File
Opening  of  mail  packets,  replies  packet  creation,  file  management,  printer
configuration.

Edit
Windows Cut, Copy, and Paste functions during editing.

View Items
Choose items that are available in the mail packet.

View Lists
See what conferences are available when entering new mail.

Tools
Create a twit list, select messages based on a query, add or delete conferences.

Quick Configuration
Set up user preferences. See Section 4.

About
Version number, date, and author's copyright notice. See Section 13.

When reading your mail you will use the File menu to select a packet and then the View
Items menu to see what is available for you to read.

5.1 File Menu

In order to get to your downloaded mail packet, click on the File menu. The choices are:

Open Mail Packet

17



Select a mail packet to open.

Create Replies Packet
After finishing entering replies, create a mail packet for uploading.

Delete Mail Packet
Delete unwanted mail packets.

Save Message as Text
When reading a message it can be saved as a text file.

Insert Text File
When replying to a piece of mail a pre-written text file can be inserted into the response.

Printer Config...
Set up the printer for printing out messages.

Print Message
Print the message.

Cleanup and Exit
Delete the content of the work directory and leave the program.

Exit
Leave the present mail etc. in the work directory and leave the program.

Only some of the menu choices will be available depending on the context. To get a
mail packet, choose Open Mail Packet by clicking on it.  VbReader will search in its
work directory for existing data from another mail packet. If you previously had opened
a mail packet, the work directory would contain files. At this point the program would
ask you if you wished to purge the directory to delete the old data. However, since you
do not yet have any data in the work directory,  VbReader will directly invoke a file
dialog box. The box will display the contents of the download directory from which you
can select a mail packet. Double click on your choice.

Once  a  mail  packet  is  selected,  VbReader will  launch  PKUNZIP.EXE  in  a  DOS
window to uncompress the packet. It will be expanded and the resulting files will be put
into the work directory. When the expansion process is complete, you may read the
messages.

5.2 View Items Menu

A  mail  packet  may  contain  more  items  other  than  just  mail.  There  may  be
announcements  and so  on  that  you had instructed  the  BBS to  send you when you
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configured it. Click on the View Items menu option to see what is available. A list of
options  appear;  the  ones  that  are  available  are  shown  in  a  solid  mode  while  the
unavailable ones are greyed out.

A summary of available items is:

Your Replies
Edit and manage your mail replies. This is discussed in Section 8.1.

Personal Mail
Read and manage your personal mail from all conferences for the mail packet.

Join Conference
Pick a conference to read mail from.

New Files
Read the file of new files available on the BBS.

BBS News
Read the BBS news files.

Bulletins
Read the BBS bulletins.

Services
List the BBS services such as newspapers, externally supplied files, etc.

Magazines
List the BBS magazines.

Welcome Screen
Read the BBS opening screen.

Goodbye Screen
Read the BBS closing screen.

5.2.1 Personal Mail Choice

If  there  was  any  personal  mail  in  your  opened  packet  there  will  be  a  beep  and
information window to indicate it.

Clicking on this option will  cause  VbReader to list  your personal messages. If any
exist, a list will appear, listing the message dates, originator, destination (you) and the
subject. Double-click on the desired message to view it. You may also use the Arrow
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keys or Page Down or Page Up keys to select a message and press Enter to view it.

When you are finished reading your personal mail click on the Done button.

5.2.2 Join Conference Choice

When you configured the mail utility on the BBS you chose a number of conferences to
monitor. The mail that was gathered for you, whether it was personal to you or public,
will be available for you to read.

Clicking on this item will cause a list of conferences to be displayed. Only conferences
in which there are any messages to be read will be listed. The list also displays the
number of messages in each conference. To choose a conference, double-click on any
one of them. A list  showing the available  messages  is  displayed.  Like the Personal
Messages list, it displays the Subject, Message Number, Originator, Destination and the
message index number. Double Click on a message to view it., or use the Arrow Keys,
Page Down or Page Up Keys followed by ENTER.

More detail is provided below to get the most out of this important item.

5.2.3 New Files Choice

This  menu item will  cause  VbReader to  invoke the editor program selected in  the
Quick Configuration | Editor Selections | Files List Editor configuration option. The
default  is  WRITE.EXE.  The editor  will  then display the list  of  new files which is
usually included in your mail packet. While in the editor, you may search for topics, edit
the file, and generally use normal editor functions.

5.2.4 BBS News Choice

This  menu item will  cause  VbReader to  invoke the editor program selected in  the
Quick Configuration | Editor Selections | News Editor configuration option. This will
normally be VBANSI.EXE; this Windows ANSI view will display ANSI files in color.

5.2.5 Bulletins Choice

This  menu item will  cause  VbReader to  invoke the editor program selected in  the
Quick Configuration | Editor Selections | Bulletins Editor configuration option. If
Bulletins were included in the mail packet, a list will appear listing the bulletins. Double
click on a bulletin to run VBANSI.EXE.

5.2.6 Services Choice

If Services were included in the packet, a list will appear listing them. You will then
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have to manually launch an editor, and/or PKUNZIP to process the service.
5.2.7 Magazines Choice

If Magazines were included in the packet, a list will appear listing them. You will then
have to manually launch an editor, and/or PKUNZIP to process the magazine
.
5.2.8 Welcome Screen Choice

This  menu item will  cause  VbReader to  invoke the editor program selected in  the
Quick Configuration | Editor Selections |  Ansi  Viewer  configuration option.  This
option launches the viewer and displays the BBS Welcome Screen. This will normally
be VBANSI.EXE.

5.2.9 Goodbye Screen Choice

This  menu item will  cause  VbReader to  invoke the editor program selected in  the
Quick Configuration | Editor Selections | Ansi Viewer configuration option. Like the
BBS News menu, this option launches the viewer and displays the BBS goodbye screen,
if this screen was included with your mail packet. This will normally be VBANSI.EXE.

5.3 Managing the Reader Screen

While reading mail you may select messages to view by one of two methods: mouse or
keyboard.

5.3.1 Mouse Method

First, you may use the horizontal scroll bar at the bottom right of the screen. The scroll
bar has a unique flashing "thumb button" on it. Clicking on the arrowed buttons with the
mouse at either end will select the next or previous message in the conference. The right
hand button goes forward and the left one goes in reverse. Clicking on the scroll bar will
increment  or  decrement  the  message  pointer  by  larger  amounts  (total  number  of
messages / 10). You may also click on the thumb button and drag it left or right, thereby
selecting messages.

5.3.2 Keyboard Method

For faster control of the screen, you may use the arrow keys. The up and down arrow
keys will scroll the view screen up and down by a full screen. The left and right arrows
will select the previous and next message, respectively.

For the keys to function as expected, the scroll bar must have the focus. Should the keys
cease to function as expected, use the mouse and click on the scroll bar to restore the
focus to that control. 
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All controls displayed in the reader screen have ALT keys assigned to them; they are
called accelerator keys in Windows. Each control has an underlined letter in its caption.
To activate a control, press the ALT key and the underlined letter to give the desired
result.

5.4 The Message List

The Message list will appear once you select a conference from the Conference list after
choosing  View Items |  Join Conference.  You choose a message to  read by double
clicking on it. A Message List button will appear on the screen. While reading messages
you may view the message list once more by clicking on the Message List button bar
under the message scroll bar at the bottom right of the reader screen. You may also use
the ALT_M key combination. 

While viewing the message list, the Up and Down arrows will move the selection bar up
or down by one message.  PgUp and  PgDn will move the selection bar for an entire
screen. You may read a selected message by double clicking on it, or by pressing the
ENTER key.

You can move to specific messages by typing the first letter of the subject field for the
message.

When you are finished or replying to messages press the Done button to return you to
the main menu choices.

5.4.1 Killing Messages

When you select the  Message List  you will see that the first message you read was
highlighted and the last message you read was outlined. You may select all the read
messages in that group by doing a  SHIFT CLICK on the outlined message. You can
then click on the  Kill button to mark the messages as "killed" which means that they
will be passed over if you attempt to read them again. When you first kill a message you
will see "KILLED" in the message which indicates the action taken.

You  can  also  select  messages  to  kill  or  restore  by  doing  a  CLICK AND  DRAG
operation on the message list.

While reading a message you can kill it by pressing the Kill button.

5.4.2 Restoring Messages

If you choose a killed message from the Message List you can unkill it by pressing the
Restore button. A range of killed messages may be restored by doing the choose and
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SHIFT click operation and pressing the Restore button.

6.0 Replying to Mail

After having read your mail, or other people's mail, you may want to respond either
publicly or privately to the originator,  addressee,  or some other individual.  You can
enter a new message too, if you want.

6.1 Starting a Reply

While reading messages, you may enter a reply by clicking on the Reply button. At this
point  VbReader will  ask if  you wish to  include  the message  in  your  reply.  If  you
answer  'yes',  the  message  will  be  copied  to  the  edit  screen  and  include  a  quote
announcement at the top of the message. The announcement refers to the name of the
originator and the date. Otherwise, the reply screen will be shown empty.

6.2 Controlling the Reply Destination

Normally, the reply is automatically addressed to the person whose name appears in the
From: field at  the bottom right of the read screen.  In most cases,  this  is  adequate.
However, in some cases, you may wish to address your reply to the person who started
the subject thread. In such cases, you may re-direct the reply by doing the following:

Before pressing the Reply button, use the mouse and select the name of the person in
the TO: field at the bottom right of the reader screen. Like all Windows programs, you
select the name by a  CLICK AND DRAG operation on the field. Once the name is
selected, copy it to the clipboard by typing CNTRL_INSERT. Invoke the reply screen
and paste the new destination over the TO: field by selecting the name (CLICK AND
DRAG) and typing SHIFT_INSERT. You may also need to modify the quote line at
the top of the message, depending on the context.

Should you wish to send this reply to a person whose name is not displayed anywhere,
just type the correct name in the TO: field.

6.3 Setting the Message Security

The  message  you  enter  may  be  either  Private  or  Public.  When  private,  only  the
recipient may read it. When public, anyone in the conference will be able to read it. The
security level is set by clicking on the appropriate radio button control at the bottom of
the screen.

6.4 Other Message Displays

At the bottom of the reply screen you will see a number of display fields. They are used
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to display information about your message. This includes:

Conf Num: This is the number of the conference where the mail resides.
Ref Num: This is a previous mail number that the mail refers to.
Msg Time: This is the time of your mail reply.
Date: This is the date of you mail reply.
Sys Time: This is the current system time.

6.5 Editing Commands

The editor is not very complex but is quite functional. You may use the mouse to move
the cursor to any insertion point in the text. The mouse will also allow you to select text
by doing a Click and Drag operation.  SHIFT_PGDN will select all the text from the
cursor to the end of the message.

Once text is selected you may delete it by using the DELETE key and cut or copy it to
the clipboard by using the Edit menu. SHIFT_DELETE will cut the selected text and
move it to the clipboard.

Once text is in the clipboard, you may paste it to another location. As a short cut, you
may use the  CNTRL_INSERT and  SHIFT_INSERT key strokes to copy text to the
clipboard and to paste it back in your message. The clipboard mechanism also allows
text to be transferred to and from other applications; this is a Windows feature.

The text will automatically wrap at the right edge of the screen so there is no need to
worry about a right margin. If you press the  ENTER  key, the cursor will move the
insertion point immediately to the next line. Therefore, while typing new text, do not
use the  ENTER key at the end of each line. This inserts a "hard" new line character.
This is unnecessary as  VbReader will automatically format your message when it is
saved.  The  reason  is  that  you may be  using  proportional  fonts,  in  which  case  line
lengths will vary for a given number of characters. Pressing the ENTER key will insert
a hard new line character, probably at the wrong place. Use the  ENTER key only to
terminate a paragraph.  VbReader functions very much like a word processor in this
regard.

Remember,  even  if  a  line  of  text  appears  overly  long,  do  not  type  ENTER.  Let
VbReader wrap it on screen, and format it when the message is saved.

Should you wish to verify the formatting, use the  View Items | Your Replies menu
item. This will allow you to view and re-edit your replies. At this point the message has
been formatted for  display  in  a  standard DOS editor  screen (i.e.:  the  line length  is
adjusted to fit in a 80 character DOS editor screen.

Should the editing process (for a previously entered reply) involve changing the length
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of a line, delete the CRLF (carriage return and line feed) characters at the end of the line
(restore the basic reader screen wrap). When the message is saved, it will be reformatted
properly.

Tabs are inserted by typing the  CNTRL_TAB key sequence. That is because the Tab
keystroke is used to navigate between screen objects and controls in Windows.

6.6 Tagline Selection

A tagline is normally a one line addition to the bottom of your message. It is normally
used to  add a  "one liner"  to  your  message.  They can be humorous,  informative,  or
whatever you want.

Once your message is complete, you may wish to select an appropriate tagline. At the
bottom center of the screen, you will see a button marked Tag Line. Clicking on this
button will  invoke the tag selection window. This consists  of a  drop-down list  box.
When first  invoked, the list  box displays the current tagline.  Clicking on the arrow
button on the right of the text box will cause a list of taglines to be displayed. If the
number of taglines exceeds the area available to display them, a scroll bar will also
appear. Select the desired tagline by clicking on it. Click on the OK button to return to
the edit screen. Note that the list box can only display the first 1000 taglines in your tag
file. The tagline is not displayed in the edit screen; it is appended to the end of your
message when you save it.

6.7 Saving the Message

When you are done with the editing, click on the Save button. A dialog box will appear
asking you for confirmation.  If you confirm that you wish to save the message,  the
message will be appended to the reply file in the  REPLIES directory. If you select
Cancel, you will be returned to the edit screen. Clicking the NO button will delete the
reply and return you to the read screen.

When you have finished responding to the messages you can re-edit them (see Section
8.1) by using the View Items | Your Replies, enter new ones (see Section 7), or create a
package of compressed replies for the BBS (see Section 9.2) by using the File | Create
Replies Packet.

7.0 Entering a New Message

Click on the New button to enter a new message not linked to any particular message in
a  conference.  The  procedure  is  very  similar  to  the  Reply procedure  except  for  the
following.

7.1 Selecting a Message Conference
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When  entering  a  new  message,  you  may  explicitly  declare  which  conference  your
message in intended for. You may either type the conference number in the appropriate
field at the bottom left of the editor screen, or you may pick a conference from a list that
is displayed when you click the View Lists menu item in the menu bar at the top of the
screen.

When the list is displayed, select a conference by double clicking on it. The list will
display 10000 conferences in three panels.

7.2 Selecting a Recipient

To address the message to a recipient, simply type the person's name in the TO: field at
the bottom right of the edit screen.

7.3 Completion of Reply Messages

When you have finished entering messages you can re-edit the replies (see Section 8.1)
by using the View Items | Your Replies or create a package of compressed replies for
the BBS (see Section 9.2) by using the File | Create Replies Packet.

8.0 View Items Menu

Most of the View Items Menu have been described above in Section 5.2. The available
choices are:

Your Replies
Personal Mail
Join Conference
New Files
BBS News
Bulletins
Services
Magazines
Welcome Screen
Goodbye Screen

One important Choice not yet discussed allows you to manage your replies.

8.1 Your Replies Choice

Before sending your replies to the BBS for everyone to read, you may wish to read them
and perhaps edit them. This can be accomplished with the View Items | Your Replies
Choice option.
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Clicking this option will bring up a list of your replies. Double-click on the reply you
wish to read. It will be displayed in the Read window. The Replies feature works in the
same manner as the Read Messages mode.

When the editing of replies is complete, pressing the  Done button will cause the old
replies to be erased and a new reply file created with the newly edited replies.

As it stands, your replies are not yet a packet for uploading to the BBS. You can leave
VbReader and come back later to continue to create more replies and they will  be
added to the existing ones. When you have finished all the replies you can bundle them
together by creating a replies packet. See Section 9.2.

9.0 Files Menu

Most of the items in the File Menu have been discussed above. For completeness they
are all listed again and the remaining ones are dealt with here.

9.1 Open Mail Packet

Select a mail packet to open. For a description see Section 5.1.

9.2 Create Replies Packet Choice

When you are finished editing all your replies you will want to select the File | Create
Replies Packet option so you can upload them to the BBS. This choice will launch the
compression program, PKZIP.EXE, which will  compress  your replies and move the
resulting file to your upload directory which you configured in Quick Configuration |
Paths | Uploads. You will be asked if you wish to delete the old replies (the ones that
are now being processed). If a mail packet exists in the upload directory, the program
will ask whether you wish to continue. If you continue, the old replies packet will be
overwritten.

Once your reply packet is created, launch your communication program and upload it.
The BBS will manage your replies from then on.

9.3 Delete Mail Packet Choice

Choose this item to display a list of mail packets that you may choose to delete from.
Use standard Windows techniques to choose the files.

9.4 Save Message as Text Choice

While in the editor window, you may save the displayed text in the editor window. Save
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the message as a plain ASCII text by using this option. This works whether you are
replying or reading messages.

9.5 Insert Text File Choice

While in the editor window, you may insert a text file. Insert plain ASCII text into your
reply message by using this option. This is useful when you want to insert the same
prepared text into replies for a number of conferences or a number of individuals.

9.6 Printer Configuration Choice

VbReader can print a single message at a time. The printing feature is fairly basic in
that there are no provisions for pagination of multiple page messages, even though it
will  print  multiple  page  messages.  However,  most  messages  that  you  write  will
probably fit onto a single page.

In the File menu item, you will find the Printer Config... item. Clicking on this item
will bring up a dialog box containing printer configuration items relating to VbReader.
You have control over the following options.

9.6.1 Printer Font

This  is  a  combo box containing the available  printer  fonts  for  the  printer  presently
selected.  The  current  font  is  displayed  in  the  text  box  portion  of  the  combo  box.
Clicking the button on the right hand side of the box will expand the list to display all
the available fonts. Click on the desired font to select it.

9.6.2 Font Size

Use this text box to select the printer font size. Type in the size that you wish to use. If
this size is not available, Windows will substitute the closest match.

9.6.3 Left Margin

This is the width of the left margin in inches; one inch is usually a good choice.

9.6.4 Top Margin

This is the top margin spacing. For most single sheet dot matrix printers, set this to 0.
For most other kinds of printers, set it to one inch.

9.7 Print Message Choice

When you are reading messages you can print them out to the printer by choosing this
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item. Your printer is configured as previously discussed.

9.8 Cleanup and Exit Choice

Delete the contents of the work directory and leave the program. Your replies will be
left intact in the Replies directory.

9.9 Exit Choice

Leave the present mail etc. in the work directory and leave the program. You are able to
come back and continue on with the existing mail packet.

10.0 Edit Menu

While editing messages you are able to use the Cut, Copy, and Paste functions that are
commonly used in Windows applications. Use the mouse to select text and use Cut to
extract the text out of the message to the Clipboard.  You can position the mouse at
another place within the text to either Copy or Paste the text.

11.0 View Lists Menu

When entering new mail you may see the list of available conferences to write into by
choosing this item.

12.0 Tools Menu

There are a number of useful utilities that can be used in VbReader:

Twit Filter
Create a list of individuals whose messages will not appear.

Queries
Search message title or text for key words.

Add Conference
Create a message to instruct the host BBS mail program to add a conference from a list.

Drop Conference
Create a message to instruct the host BBS mail program to delete a conference from a
list.

12.1 Twit Filter Choice

Sometimes you may not want to see messages from certain individuals. The Twit Filter
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allows you to screen them out.

Under the Tools menu, you will find the Twit Filter option. This will invoke a dialog
box containing a Combo box, a check box and a couple of control buttons.. The Combo
box contains a list of names of message originators which you wish removed from all
message  lists.  You  can  add  names  and  remove  them  at  will.  When  VbReader is
terminated, all changes to the twit list are saved in a file called TWITFILE.TXT in the
DATAFILE directory.

When the Twit Filter is activated via the check box, all messages bearing a author name
included in the twit list are deleted from the message lists. Should you wish to see them,
turn off the filter and re-select the conference you are interested in. As the message list
is processed, messages previously filtered out will re-appear.

The Twit Filter can be applied to SUBJECT, FROM, and TO fields.

12.2 Queries Choice

The  Queries feature in  VbReader enables you to show you a class of messages that
you  can  include  or  exclude  depending  on  criteria  that  you  provide.  For  example,
suppose you want all messages in a conference that have the word "VBREADER" in the
title of the message. You would use the query feature to find them all for you. It is not
case sensitive.

The query is based on a number of key words that you provide in the list box when you
select the Queries Choice. Type in the key word you want and then click on Insert to
active it.  Insert more key words for your search pattern. The search will succeed on
finding any key word.

You can delete key words in the list box by clicking on the word after activating the list
with the arrow down symbol to the right of the list box. Click on Remove to delete it
from the list. If you want to remove all the key words then click on Clear All.

Normally  the  query  is  applied  to  the  message  title;  however,  you  may  include  the
message content as well by clicking on the box for Include Msg Text.

The Action of the query is to give you a list of messages that either satisfies the search
criterion or not. Use the  Include action to give you a list of messages that satisfy the
query key words; otherwise, use the Exclude action to give you a list of messages that
do not satisfy the query key words.

To start the search, click on Do it.

To cancel the effect of the query, click on Undo Queries.
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Since the queries operate on the message list contents you can run successive queries to
progressively zero in on the desired query criterion.

The queries are not saved; they are only valid while the queries screen is loaded. Do not
close the query screen if you want to use its query list again; shrink it or put it in the
background.

12.3 Add Conference Choice

Mail utilities found on a BBS enable you to add or delete conferences that you wish to
monitor. You can use VbReader to send messages to the BBS to do this for you.

When you first set up the conference list you wish to monitor on the BBS you can
usually have the BBS download a list of just the conferences that you monitor or a
complete  list  of all  available conferences.  If  you get  the full  list  you may add new
conferences to monitor.

When you choose to  Add Conference  you will be given an informational message to
Double Click on the Conference to be Added... Click on  OK to accept the message.
Three panes of conferences will be available for you to choose from. When you choose
one you will be asked,  Do you wish to receive Personal Mail? Click on  YES or  NO
depending on your preference. You will then be asked whether you want to Add another
Conf. Click on YES or NO depending on your preference. Continue if you agreed. If you
did not want to add another conference you will be asked,  Do you wish to save this
message?  If you save the message it will be sent to the BBS when you create a mail
packet (see Files | Create Replies Packet); otherwise, nothing will be done.

Depending on the mail door type that you chose in the Quick Configuration | Packers
and Door Commands, the exact sequence and dialog text will vary. For example, some
mail doors will not allow multiple conferences to be added or dropped in one message. If
you had chosen such a door type, for example CMPMAIL, then you will not get  Add
another Conf dialog box message.

12.4 Drop Conference Choice

You can delete a conference in a similar fashion to adding a conference.

13.0 About Menu

When you click on this menu item you will find the VbReader version number, date,
and author's copyright notice.

14.0 VbReader Limitations
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Number of conferences containing messages: 700
Number of messages per conference: 700
Number of conferences listed in the View List menu: 10000
Maximum conference Number: 9999
Number of messages per Conference: 700
Number of replies: 700
Number of taglines displayed in the list box: 1000

15.0 Acknowledgments

VbReader would not have been possible without a small but indispensable document
written by Patrick Y. Lee, which detailed the format of the QWK mail packets.

A large number of improvements were suggested by beta testers and other dedicated
users. Major contributors are listed below in alphabetical order:

David Anjo
Adam Baker
Wayne Husted
Michael Livsey
Colin Perkel
Eugene Sunday

There are others too. Those of you who have contributed know who you are and please be
assured that your contribution and support were and are still valued tremendously.

32


